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Connect Power
When all other connections have been made, you can connect power to the Prototyping Board. Connect the 
wall transformer to 3-pin header J1 on the Prototyping Board as shown in Figure 3. The connector may 
be attached either way as long as it is not offset to one side—the center pin of J1 is always connected 
to the positive terminal, and either edge pin is negative.
Plug in the wall transformer. The power LED beside the RESET button on the Prototyping Board should 
light up. The RCM3720 and the Prototyping Board are now ready to be used.

NOTE: The RESET button is provided on the Prototyping Board to allow a hardware reset with-
out disconnecting power.

Alternate Power-Supply Connections

The 3-pin connector allows you to connect your own power supply—connect the center pin to the positive 
terminal, and connect either edge pin to the negative terminal. The power supply should deliver at least 200 mA 
at 7.5 V–15 V DC.

Dynamic C—RCM3720 Module
Once the RCM3720 is connected as described in the preceding pages, start Dynamic C by double-clicking 
on the Dynamic C icon or by double-clicking on dcrab_XXXX.exe in the Dynamic C root directory, 
where XXXX are version-specific characters. Dynamic C uses the serial port specified during installation.

If you are using a USB port to connect your computer to the RCM3720, choose Options > Project 
Options and select “Use USB to Serial Converter.”

Run a Sample Program

Use the File menu to open the sample program PONG.C, which is in the Dynamic C SAMPLES folder. 
Press function key F9 to compile and run the program. The STDIO window will open on your PC and will
display a small square bouncing around in a box. Running this sample program successfully demonstrates
that the RCM3720 module is connected correctly

Set Up RF Interface Modules and Prototyping Board
Use a 10-pin to 10-pin IDC serial cable with a 0.1" pitch to connect header J6 of the “coordinator” RF 
Interface module to header J3, the RS-232 header on the RCM3720 Prototyping Board. Line up the red 
colored edge with pin 1. Place the “child” RF Interface modules up to 100 ft (30 m) away.

Where Do I Go From Here?
You are now ready to go on to other sample programs and to develop your own applications. Applica
tion Note AN413, ZigBee™ 802.15.4 Application Kit, takes you through loading and using the 
sample programs included with the supplemental CD, and describes Rabbit Semiconductor’s software
drivers. The RCM3700 User's Manual provides complete hardware reference information and 
describes the software function calls for the RCM3720 and the Prototyping Board. The supplemental
CD contains additional information about the XBee™ RF modems and their use and specifications.

Troubleshooting

• Use the Dynamic C Help menu to get further assistance with Dynamic C.

• Check the Rabbit Semiconductor Technical Bulletin Board at www.rabbit.com/support/bb/.

• Use the Technical Support e-mail form at www.rabbit.com/support/.

NOTE: If you purchased your ZigBee™ 802.15.4 Application Kit through a distributor or through
a Rabbit Semiconductor partner, contact the distributor or partner first for technical support.

Installing Dynamic C®

Insert the Dynamic C CD from the Application Kit in your PC’s CD-ROM drive. 
If the installation does not auto-start, run the setup.exe program in the root 
directory of the Dynamic C CD. Install the software from the supplemental CD 
after you install Dynamic C.
Rabbit and Dynamic C are registered trademarks of Rabbit Semiconductor Inc.

ZigBee™/802.15.4 Application Kit
Application Kit Contents
• 2 CD-ROMs — Dynamic C® with complete product documentation on disk, and supplemental CD 

with sample programs and information related to ZigBee™/802.15.4 Application Kit.
• RCM3720 module.
• RCM3720 Prototyping Board.

• 3 Maxstream XBee™ RF modems.

• 3 RF Interface modules for use with XBee™ RF modems.

• AC adapter, 12 V DC, 1 A, for use with RCM3720 module and Prototyping Board. If you are using 
your own power supply, it should deliver a DC output of 7.5–15 V.

• Programming cable with 10-pin header and DB9 connections, and level-matching adapter board.

• 2 10-pin to 10-pin IDC header serial cables, one with 0.1" pitch, one with 1.27 mm pitch.

• 4 standoffs for RCM3720 Prototyping Board and 12 standoffs for RF Interface modules.

• Bag containing accessory parts, jumpers, 9 AAA batteries, 3 battery holders.

• Getting Started instructions.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.
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1. Under the “Modem Configuration” tab choose “XB24” from the “Modem” pull-down menu.

2. Choose “XBEE 802.15.4” or the “COORDINATOR”/”ROUTER” from the “Function Set” pull-down menu.

3. Choose “1yyy” or “8yyy” from the “Version” pull-down menu (“1yyy” or “8yyy” matches the version number 
in the file name). The “8yyy” versions have options depending on whether you are configuring the coordinator 
or a router.

4. Check the “Always update firmware” box.

5. Click “Write” to load the XBee™ RF modem with the new firmware.

RCM3720 Module Connections
To facilitate handling the Prototyping Board, snap in the four 
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RF Interface Module Connections
Set up all three RF Interface modules as 
explained in these instructions.

1. Snap in four standoffs to the four holes at the 
corners on the bottom side of the RF Inter-
face module.

2. Install the XBee™ RF modem into the 
inside-facing sockets of header sockets J1 
and J2 on the RF Interface module. Press the 
XBee™ modem’s pins firmly into the RF 
Interface module header sockets.
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3. Place 3 AAA batteries in a battery holder, 
then connect the red wire from the battery 
holder to the + terminal of screw terminal 
header J3, and connect the black wire from 
the battery holder to the – terminal of screw 
terminal header J3.
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standoffs to the four holes at the corners on the bottom side of the 
Prototyping Board before continuing with the remaining steps.

Attach Module to Prototyping Board
Turn the RCM3720 module so that the Ethernet jack is on the left as 
shown in Figure 2 below. Insert the module’s J1 header into the J5 
socket on the Prototyping Board. The shaded corner notch at the bot-
tom right corner of the RCM3720 module should face the same direc-
tion as the corresponding notch below it on the Prototyping Board.

NOTE: It is important that you line up the pins on header J1 
of the RCM3720 module exactly with the corresponding 
pins of the J5 socket on the Prototyping Board. The 
header pins may become bent or damaged if the pin align-
ment is offset, and the module will not work. Permanent 
electrical damage to the module may also result if a mis-
aligned module is powered up.

Press the module’s pins firmly into the Prototyping Board socket.

Connect Programming Cable
The programming cable with the RCM3720 adapter 
board connects the RCM3720 to the PC running 
Dynamic C to download programs and to monitor the 
RCM3720 module during debugging.
Attach the DB9 connector end of the programming 
cable to a COM (serial) port on the PC. Dynamic C 
uses a COM port to communicate with the target 
system. The default selection is COM1, but you may 
select a different COM port when you install or run 
Dynamic C.
Connect the 10-pin connector of the programming 
cable and adapter board to header J2 on the RCM3720 
as shown in Figure 3. The adapter board converts the 
PC voltage to the voltage on the RCM3720. Orient the 
programming cable and adapter board as shown in 
Figure 3 so that the colored edge of the programming 
cable lines up with the dot on the adapter board and pin 
1 on the RCM3720.
Connect the other end of the programming cable to a 
COM port on your PC.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use an RS-232/USB converter 
(Part No. 540-0070) with the programming cable supplied with this Application Kit. Note that not all RS-232/
USB converters work with Dynamic C.

Figure 2.  Install the RCM3720 Module on 
the Prototyping Board
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Figure 3.  Connect Programming Cable
and Power Supply
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If the battery holder has an on/off switch on 
the opposite side, make sure the switch is in 
the ON position.
You may use your own power supply with 
an output of 3.5–6.0 V DC.

4. Install 5 jumpers on header J5 for the DCE 
configuration shown in Figure 1.

5. Use the same programming cable used to connect the RCM3720 to connect the RF Interface module to your PC 
to download the firmware.
Connect the 10-pin connector of the programming cable (the RCM3720 adapter board must be removed) to 
header J6 on the RF Interface module. Line up the colored edge of the programming cable with pin 1 of header 
J6 as shown. The DB9 connector end of the programming cable is attached to a COM (serial) port on the PC.

It is recommended that you assign a unique “name” to each RF Interface module, and place a sticker on the module 
to identify it. You will have one “coordinator” device and two “children.” The “coordinator” RF Interface module 
will be connected to the RS-232 header on the Prototyping Board, and the “children” can be up to 100 ft (30 m) away.

Install the XBee™ RF Modem Firmware
1. Locate and double-click Setup_x-ctu_5013.exe in the Dynamic C DCRabbit…\xbee firmware 

directory to install the X-CTU application that you will use to download the firmware.
2. Start X-CTU from the desktop icon and set the “PC Settings” tab to 9600 baud, HARDWARE flow control, 

8 data bits, parity NONE, 1 stop bit.
3. Under the “Modem Configuration” tab click the “Download new versions…” button, select “File,” and browse 

the Dynamic C DCRabbit…\xbee firmware directory to select the ZIP file corresponding to your network. 
There are two firmware options, depending on whether you will be using a peer-to-peer (802.15.4, NonBeacon) 
network or a mesh (ZigBee™) network (XBee_1yyy.zip for a peer-to-peer network, or XBee_8yyy.zip 
for a mesh network, where yyy specifies the version number).

4. Select the ZIP file, click “Open,” “OK,” then “Done.”
You are now ready to load the three XBee™ RF modems with the new firmware. Repeat the remaining steps for 
each of the three RF Interface modules with their XBee™ RF modems installed and the programming cable 
connected to header J6 of the RF Interface modules. Remember to set the jumpers on header J5 for the DCE 
configuration shown in Figure 1.

Figure 1.  RF Interface Module Connections
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RF Interface Module Connections
Set up all three RF Interface modules as 
explained in these instructions.

1. Snap in four standoffs to the four holes at the 
corners on the bottom side of the RF Inter-
face module.

2. Install the XBee™ RF modem into the 
inside-facing sockets of header sockets J1 
and J2 on the RF Interface module. Press the 
XBee™ modem’s pins firmly into the RF 
Interface module header sockets.

3. Place 3 AAA batteries in a battery holder, 
then connect the red wire from the battery 
holder to the + terminal of screw terminal 
header J3, and connect the black wire from 
the battery holder to the – terminal of screw 
terminal header J3.
If the battery holder has an on/off switch on 
the opposite side, make sure the switch is in 
the ON position.
You may use your own power supply with 
an output of 3.5–6.0 V DC.

4. Install 5 jumpers on header J5 for the DCE 
configuration shown in Figure 1.

5. Use the same programming cable used to connect the RCM3720 to connect the RF Interface module to your PC 
to download the firmware.
Connect the 10-pin connector of the programming cable (the RCM3720 adapter board must be removed) to 
header J6 on the RF Interface module. Line up the colored edge of the programming cable with pin 1 of header 
J6 as shown. The DB9 connector end of the programming cable is attached to a COM (serial) port on the PC.

It is recommended that you assign a unique “name” to each RF Interface module, and place a sticker on the module 
to identify it. You will have one “coordinator” device and two “children.” The “coordinator” RF Interface module 
will be connected to the RS-232 header on the Prototyping Board, and the “children” can be up to 100 ft (30 m) away.

Install the XBee™ RF Modem Firmware
1. Locate and double-click Setup_x-ctu_5013.exe in the Dynamic C DCRabbit…\xbee firmware 

directory to install the X-CTU application that you will use to download the firmware.
2. Start X-CTU from the desktop icon and set the “PC Settings” tab to 9600 baud, HARDWARE flow control, 

8 data bits, parity NONE, 1 stop bit.
3. Under the “Modem Configuration” tab click the “Download new versions…” button, select “File,” and browse 

the Dynamic C DCRabbit…\xbee firmware directory to select the ZIP file corresponding to your network. 
There are two firmware options, depending on whether you will be using a peer-to-peer (802.15.4, NonBeacon) 
network or a mesh (ZigBee™) network (XBee_1yyy.zip for a peer-to-peer network, or XBee_8yyy.zip 
for a mesh network, where yyy specifies the version number).

4. Select the ZIP file, click “Open,” “OK,” then “Done.”
You are now ready to load the three XBee™ RF modems with the new firmware. Repeat the remaining steps for 
each of the three RF Interface modules with their XBee™ RF modems installed and the programming cable 
connected to header J6 of the RF Interface modules. Remember to set the jumpers on header J5 for the DCE 
configuration shown in Figure 1.

Figure 1.  RF Interface Module Connections
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1. Under the “Modem Configuration” tab choose “XB24” from the “Modem” pull-down menu.

2. Choose “XBEE 802.15.4” or the “COORDINATOR”/”ROUTER” from the “Function Set” pull-down menu.

3. Choose “1yyy” or “8yyy” from the “Version” pull-down menu (“1yyy” or “8yyy” matches the version number 
in the file name). The “8yyy” versions have options depending on whether you are configuring the coordinator 
or a router.

4. Check the “Always update firmware” box.

5. Click “Write” to load the XBee™ RF modem with the new firmware.

RCM3720 Module Connections
To facilitate handling the Prototyping Board, snap in the four 
standoffs to the four holes at the corners on the bottom side of the 
Prototyping Board before continuing with the remaining steps.

Attach Module to Prototyping Board
Turn the RCM3720 module so that the Ethernet jack is on the left as 
shown in Figure 2 below. Insert the module’s J1 header into the J5 
socket on the Prototyping Board. The shaded corner notch at the bot-
tom right corner of the RCM3720 module should face the same direc-
tion as the corresponding notch below it on the Prototyping Board.

NOTE: It is important that you line up the pins on header J1 
of the RCM3720 module exactly with the corresponding 
pins of the J5 socket on the Prototyping Board. The 
header pins may become bent or damaged if the pin align-
ment is offset, and the module will not work. Permanent 
electrical damage to the module may also result if a mis-
aligned module is powered up.

Press the module’s pins firmly into the Prototyping Board socket.

Connect Programming Cable
The programming cable with the RCM3720 adapter 
board connects the RCM3720 to the PC running 
Dynamic C to download programs and to monitor the 
RCM3720 module during debugging.
Attach the DB9 connector end of the programming 
cable to a COM (serial) port on the PC. Dynamic C 
uses a COM port to communicate with the target 
system. The default selection is COM1, but you may 

Figure 2.  Install the RCM3720 Module on 
the Prototyping Board
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select a different COM port when you install or run 
Dynamic C.
Connect the 10-pin connector of the programming 
cable and adapter board to header J2 on the RCM3720 
as shown in Figure 3. The adapter board converts the 
PC voltage to the voltage on the RCM3720. Orient the 
programming cable and adapter board as shown in 
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Figure 3 so that the colored edge of the programming 
cable lines up with the dot on the adapter board and pin 
1 on the RCM3720.
Connect the other end of the programming cable to a 
COM port on your PC.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use an RS-232/USB converter 
(Part No. 540-0070) with the programming cable supplied with this Application Kit. Note that not all RS-232/
USB converters work with Dynamic C.

Figure 3.  Connect Programming Cable
and Power Supply



ZigBee™ 802.15.4 Application Kit
Application Kit Contents
• 2 CD-ROMs — Dynamic C® with complete product documentation on disk, and supplemental CD 

with sample programs and information related to ZigBee™ 802.15.4 Application Kit.
• RCM3720 module.
• RCM3720 Prototyping Board.

• 3 Maxstream XBee™ RF modems.

Connect Power
totyping Board. Connect the 
re 3. The connector may 

in of J1 is always connected 

e Prototyping Board should 

allow a hardware reset with-

he center pin to the positive 
hould deliver at least 200 mA 

namic C by double-clicking 
ynamic C root directory, 
ecified during installation.

e Options > Project 

mic C SAMPLES folder. 
ill open on your PC and will 
 successfully demonstrates 

 of the “coordinator” RF 
g Board. Line up the red 

30 m) away.

own applications. Applica-

Installing Dynamic C®

Insert the Dynamic C CD from the Application Kit in your PC’s CD-ROM drive. 
If the installation does not auto-start, run the setup.exe program in the root 
directory of the Dynamic C CD. Install the software from the supplemental CD 
after you install Dynamic C.
When all other connections have been made, you can connect power to the Pro
wall transformer to 3-pin header J1 on the Prototyping Board as shown in Figu
be attached either way as long as it is not offset to one side—the center p
to the positive terminal, and either edge pin is negative.
Plug in the wall transformer. The power LED beside the RESET button on th
light up. The RCM3720 and the Prototyping Board are now ready to be used.

NOTE: The RESET button is provided on the Prototyping Board to 
out disconnecting power.

Alternate Power-Supply Connections

The 3-pin connector allows you to connect your own power supply—connect t
terminal, and connect either edge pin to the negative terminal. The power supply s
at 7.5 V–15 V DC.

Dynamic C—RCM3720 Module
Once the RCM3720 is connected as described in the preceding pages, start Dy
on the Dynamic C icon or by double-clicking on dcrab_XXXX.exe in the D
where XXXX are version-specific characters. Dynamic C uses the serial port sp

If you are using a USB port to connect your computer to the RCM3720, choos
Options and select “Use USB to Serial Converter.”

Run a Sample Program

Use the File menu to open the sample program PONG.C, which is in the Dyna
Press function key F9 to compile and run the program. The STDIO window w
display a small square bouncing around in a box. Running this sample program
that the RCM3720 module is connected correctly

Set Up RF Interface Modules and Prototyping Board
Use a 10-pin to 10-pin IDC serial cable with a 0.1" pitch to connect header J6
Interface module to header J3, the RS-232 header on the RCM3720 Prototypin
colored edge with pin 1. Place the “child” RF Interface modules up to 100 ft (

Where Do I Go From Here?
You are now ready to go on to other sample programs and to develop your 
Rabbit and Dynamic C are registered trademarks of Rabbit Semiconductor Inc.020–0115 • 060915–A

• 3 RF Interface modules for use with XBee™ RF modems.

• AC adapter, 12 V DC, 1 A, for use with RCM3720 module and Prototyping Board. If you are using 
your own power supply, it should deliver a DC output of 7.5–15 V.

• Programming cable with 10-pin header and DB9 connections, and level-matching adapter.

• 2 10-pin to 10-pin IDC header serial cables, one with 0.1" pitch, one with 1.27 mm pitch.

• 4 standoffs for RCM 3720 Prototyping Board and 12 standoffs for RF Interface modules.

• Bag containing accessory parts, 9 AAA batteries, 3 battery holders.

• Getting Started instructions.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.

tion Note AN413, ZigBee™/802.15.4 Application Kit, takes you through loading and using the 
sample programs included with the supplemental CD, and describes Rabbit Semiconductor’s software 
drivers. The RCM3700 User's Manual provides complete hardware reference information and 
describes the software function calls for the RCM3720 and the Prototyping Board. The supplemental 
CD contains additional information about the XBee™ RF modems and their use and specifications.

Troubleshooting

• Use the Dynamic C Help menu to get further assistance with Dynamic C.

• Check the Rabbit Semiconductor Technical Bulletin Board at www.rabbit.com/support/bb/.

• Use the Technical Support e-mail form at www.rabbit.com/support/.

NOTE: If you purchased your ZigBee™/802.15.4 Application Kit through a distributor or through 
a Rabbit Semiconductor partner, contact the distributor or partner first for technical support.

http://www.zworld.com/support/bb/index.html
http://www.zworld.com/support/questionSubmit.shtml
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